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About this guide

This guide provides setup and troubleshooting information for your workstation. It includes these topics:

Guide topics

Locating HP resources on page 1

Workstation features on page 6

Setting up the workstation on page 12

Setting up, backing up, restoring, and recovering Windows
7 on page 22

Setting up, backing up, restoring, and recovering Windows
8 on page 28

Setting up and restoring Linux on page 36

Diagnostics and Minor Troubleshooting on page 43

Routine Care on page 49

TIP: If you do not find what you are looking for in this guide:

— Find technical details in the Maintenance and Service Guide for your workstation at
http://www.hp.com/support/workstation_manuals.

— View component installation videos at http://www.hp.com/go/sml.

— See additional information about your workstation at http://www.hp.com/go/workstations.
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1 Locating HP resources

This section provides information about the following resources for your HP workstation:

Topics

Product information on page 2

● Technical specifications

● HP Cool Tools

● Regulatory information

● Accessories

● System board

● Serial number, Certificate of Authenticity (COA), and
Genuine Microsoft Label (GML)

Support on page 3

● Product support

● Warranty information

Product documentation on page 4

● HP and third-party documentation, white papers

● Product Change Notifications

● Technical specifications (QuickSpecs)

● Customer Advisories, Security Bulletins, Customer Notices

Product diagnostics on page 4

● HP PC Hardware Diagnostics UEFI

● Audible beeps and LED code definitions

● POST error codes

Product updates on page 5

● Driver and BIOS updates

● Operating systems
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Product information

Topic Location

Technical specifications See www.hp.com/go/quickspecs. In the left pane, select your region and then select
Workstations.

HP Cool Tools (Windows® 7
only)

Most HP workstations with the Windows 7 operating system are preloaded with tools
that may enhance system performance and with additional software that is not
automatically installed during first boot. To access these applications:

● Click the HP Cool Tools icon on the desktop, or

● Open the HP Cool Tools folder by selecting Start > All Programs > HP >
HP Cool Tools.

To learn more about these applications, click HP Cool Tools—Learn More.

To install or launch the applications, click the appropriate application icon.

Additional information is located in the Maintenance and Service Guide for your
workstation on the web at http://www.hp.com/support/workstation_manuals/.

Regulatory information Refer to the Regulatory Safety & Environmental Notices for product regulatory
information. You can also refer to the regulatory label on the workstation chassis.

Accessories For complete and current information about supported accessories and components,
see http://www.hp.com/go/workstations.

System board A diagram of the system board is located on the inside of the side access panel
(tower and desktop configurations) or on the inside of the chassis (all-in-one
configurations). Additional information is located in the Maintenance and Service
Guide for your workstation on the web at http://www.hp.com/support/
workstation_manuals/.

Serial number, Certificate of
Authenticity (COA) labels, and
Genuine Microsoft Label (GML) (if
applicable)

Serial number labels are on the top or back panel (tower and desktop
configurations). The COA (Windows 7) label and GML (Windows 8) are typically
located near the serial number label. Some workstations have this label on the bottom
panel.

Linux For information about running Linux on HP workstations, see http://www.hp.com/
linux/, and then select Linux on Workstations from the list on the left.
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Support

Topic Location

Product support For U.S. support, see http://www.hp.com/go/contactHP.

For worldwide support, see http://welcome.hp.com/country/us/en/wwcontact_us.html.

Here you can:

● Chat online with an HP technician

● Obtain email support

● Find support telephone numbers

● Locate an HP service center

Warranty
information

To locate base warranty information, see http://www.hp.com/support/warranty-lookuptool.

To locate an existing Care Pack, see http://www.hp.com/go/lookuptool.

To extend a standard product warranty, see http://h20219.www2.hp.com/services/us/en/warranty/
carepack-overview.html. HP Care Pack Services offer upgraded service levels to extend and expand a
standard product warranty.

You can find the expressly provided HP Limited Warranty applicable to your product by using the
following instructions:

● • For the Windows 7 operating system, select Start > All Programs > HP > HP
Documentation, and then select View Warranty Information from the documentation
launch panel.

● • For the Windows 8 operating system, select the HP Documentation application, and then select
View Warranty Information from the documentation launch panel.

For some countries/regions, a printed HP Limited Warranty is provided in the box. In countries/regions
where the warranty is not provided in printed format, you may request a printed copy from
http://www.hp.com/go/orderdocuments or write to:

● North America: Hewlett Packard, MS POD, 11311 Chinden Blvd, Boise, ID 83714, USA

● Europe, Middle East, Africa: Hewlett-Packard, POD, Via G. Di Vittorio, 9, 20063, Cernusco/
Naviglio (MI), Italy

● Asia Pacific: Hewlett-Packard, POD, P.O. Box 200, Alexandra Post Office, Singapore 911507

Please include your product number, warranty period (found on your serial number label), name, and
postal address.
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Product documentation

Topic Location

HP user documentation, white
papers, and third-party
documentation

For the latest online documentation, see http://www.hp.com/support/
workstation_manuals. These include this User Guide and the Maintenance and
Service Guide.

Removal and replacement videos To learn how to remove and replace workstation components, see
http://www.hp.com/go/sml.

Product notifications Subscriber's Choice is an HP program that allows you to sign up to receive driver
and software alerts, product change notifications (PCNs), the HP newsletter, customer
advisories, and more. Sign up at www.hp.com/united-states/subscribe/gateway/?
jumpid=go/subscribe-gate1.

Technical specifications The Product Bulletin contains QuickSpecs for HP Workstations. QuickSpecs include
information about the operating system, power supply, memory, CPU, and many
other system components. To access the QuickSpecs, see http://www.hp.com/go/
quickspecs/.

Customer Advisories, Security
Bulletins, and Notices

To find advisories, bulletins, and notices:

1. See http://www.hp.com/go/workstationsupport.

2. Select the desired product.

3. From the Resources section, select See more.

4. Use the scroll bar to select Customer Advisories, Customer Bulletins, or
HP product bulletins (QuickSpecs).

Product diagnostics

Topic Location

HP PC Hardware Diagnostics
UEFI

The HP PC Hardware Diagnostics tool is pre-installed on workstations using the
Windows operating system.

Additional information is located in the Maintenance and Service Guide for your
workstation on the web at http://www.hp.com/support/workstation_manuals/.

Audible beep and LED code
definitions

Refer to the workstation Maintenance and Service Guide for your workstation at
http://www.hp.com/support/workstation_manuals.

POST error codes Refer to the workstation Maintenance and Service Guide for your workstation at
http://www.hp.com/support/workstation_manuals.
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Product updates

Topic Location

Driver and BIOS updates See http://www.hp.com/go/workstationsupport to verify that you have the latest
drivers for the workstation.

To determine the current workstation BIOS on your workstation, follow these steps:

1. Turn on the workstation, and press esc during boot up.

2. Press f10 to enter Computer (f10) Setup Utility.

3. Select File > System Information. Note the BIOS version and date and
compare it with the BIOS versions that appear on the HP website.

For Windows 7, you can also find the BIOS version number, as follows:

1. Select Start > All Programs > Accessories > System Tools > System
Information.

2. In the right pane, find the line with BIOS Version/Date.

3. Note the BIOS version and date and compare it with the versions that appear
on the HP website.

In Windows 8, you can also find the BIOS version number, as follows:

1. Point to the upper-right or lower-right corner of the Start screen to display the
charms.

2. Click Settings > Change PC Settings.

Operating systems For additional information, on:

● Operating systems supported on HP workstations, see http://www.hp.com/go/
wsos.

● Windows operating systems, see http://www.microsoft.com/support.

● Linux operating systems, see http://www.hp.com/linux.
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2 Workstation features

For complete and current information about supported accessories and components for your
workstation, see http://partsurfer.hp.com.

Topics

Small form factor workstation components on page 7

Tower workstation components on page 9

Product specifications on page 11
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Small form factor workstation components
This section describes components of your small form factor (SFF) workstation.

For complete and current information about supported accessories and components for the computer,
see http://partsurfer.hp.com.

Front panel

1  Optical drive 5
Microphone or headphone connector
(software selectable, default mode is
microphone)

2 Power button 6 Headphone connector

3 Hard drive or optical drive activity light 7  
Optional memory card reader or
optional second hard disk drive

4 USB 3.0 ports (2) 8 USB 2.0 ports (2)

Small form factor workstation components 7
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Rear panel

1 PS/2 mouse connector 8  Power cord connector

2 RJ-45 Ethernet connector 9 PS/2 keyboard connector

3 Dual-Mode DisplayPort (3) 10 USB 2.0 ports (2)

4  Cable lock slot 11 Serial port (monitor)

5 USB 2.0 ports (2) 12 USB 3.0 ports (2)

6  Padlock loop lock 13 Audio line-out connector

7 Audio line-in connector
NOTE: The labels for the rear panel connectors use

industry-standard icons and colors.

NOTE: The DP port is not supported when the system is configured with Intel® Xeon E3-12x0 v3 processors. Also, if a discrete graphics card is

installed, these ports are disabled by default.

NOTE: Simultaneous usage of integrated Intel HD graphics and discrete graphics cards (in order to drive more than two displays) can be enabled using

Computer (f10) Setup Utility. However, HP recommends using only discrete graphics cards to drive more than two displays.
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Tower workstation components
This section describes the tower workstation components.

For complete and current information about supported accessories and components for the computer,
see http://partsurfer.hp.com.

Font panel

1  Optical drive 6
USB 2.0 (Always-On Charging) port
(1)

2  
Second optical drive or optional
component

7 USB 2.0 port (1)

3  Slim optical drive 8 USB 3.0 ports (2)

4
Hard drive or optical drive activity
light

9 Headphone connector

5 Power button 10` Microphone connector

Tower workstation components 9
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Rear panel

1  
Power supply Built-In Self Test (BIST)
LED

9 PS/2 mouse connector

2  Power cord connector 10 RJ-45 Ethernet connector

3 PS/2 keyboard connector 11 Dual-Mode DisplayPort (2)

4 USB 2.0 ports (2) 12  Universal chassis clamp opening

5 DVI-I connector 13  Cable lock slot

6 USB 3.0 ports (2) 14  Padlock loop

7 Microphone connector 15 USB 2.0 ports (2)

8 Audio line-out connector 16 Audio line-in connector

NOTE: The labels for the rear panel connectors use industry-standard icons and colors.

NOTE: The DP and DVI-I ports are not supported when the system is configured with Intel Xeon E3-12x0 v3 processors. Also, if a discrete graphics card

is installed these ports are disabled by default.

NOTE: Simultaneous usage of integrated Intel HD graphics and discrete graphics cards (in order to drive more than two displays) can be enabled using

Computer (f10) Setup Utility. However, HP recommends using only discrete graphics cards to drive three or more displays.
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Product specifications

Workstation weights and dimensions

Characteristic SFF Tower

Weight

Standard
configuration

7.2 kg (15.87 lb) 9.5 kg (20.94 lb)

Minimum
configuration

6.0 kg (13.23 lb) 8.8 kg (19.4 lb)

Maximum
configuration

7.9 kg (17.42 lb) 11.8 kg (26.01 lb)

Chassis dimensions
Height 33.7 cm (13.3 in) 39.9 cm (15.7 in)

Width 10.0 cm (3.9 in) 17.0 cm (6.7 in)

Depth 38.4 cm (15.1 in) 44.2 cm (17.4 in)

Environmental specifications

Temperature

Operating: 5°C to 35°C (40°F to 95°F)

Non-operating: -40°C to 60°C (-40°F to 140°F)

NOTE: Derate by 1°C (1.8°F) for every 305 m (1,000 ft) altitude over 1,524 m (5,000 ft).

Humidity
Operating: 8% to 85% relative humidity, non-condensing

Non-operating: 8% to 90% relative humidity, non-condensing

Altitude
Operating: 0 to 3,048 m (10,000 ft)

Non-operating: 0 to 9,144 m (30,000 ft)

Shock

Operating: ½-sine: 40g, 2-3ms (~62 cm/s)

Non-operating:

● ½-sine: 160 cm/s, 2-3ms (~105g)

● square: 422 cm/s, 20g

NOTE: Values represent individual shock events and do not indicate repetitive shock events.

Vibration

Operating Random: 0.5g (rms), 5-300 Hz, up to 0.0025g²/Hz

Non-Operating: random: 2.0g (rms), 5-500 Hz, up to 0.0150g²/Hz

NOTE: Values do not indicate continuous vibration.
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3 Setting up the workstation

This chapter describes how to set up your workstation.

Topics

Ensuring proper ventilation on page 13

Setup procedures on page 14

Adding monitors on page 15
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Ensuring proper ventilation
Proper ventilation for the system is important for workstation operation. Follow these guidelines:

● Operate the workstation on a sturdy, level surface.

● Provide at least 15.24 cm (6 inches) of clearance at the front and back of the workstation.
(Workstation models vary.)

● Ensure that the ambient air temperature falls within the environmental specifications listed in this
document.

NOTE: The ambient upper limit of 35°C (95°F) only good up to 1524 m (5000 ft) elevation.
There is a 1°C (33.8°F) per 304.8 m (1000 ft) derating above 1524 m (5000 ft). So, at 3,048 m
(10,000 ft), the upper ambient air temperature limit is 30°C (86°F).

● For cabinet installation, ensure adequate cabinet ventilation and ensure that the ambient
temperature within the cabinet does not exceed specified limits.

● Never restrict the incoming or outgoing airflow of the workstation by blocking any vents or air
intakes, as shown in the following figure.
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Setup procedures
WARNING! To reduce the risk of electric shock or damage to your equipment, observe these
practices:

• Plug the power cord into an AC outlet that is easily accessible.

• Disconnect power from the computer by unplugging the power cord from the AC outlet (not by
unplugging the power cord from the computer).

• Plug the cord into a grounded (earthed) three-pin outlet. Do not disable the power cord grounding
pin (for example, by attaching a two-pin adapter). The grounding pin is an important safety feature.

To set up the workstation:

1. Connect the mouse, keyboard, and power cord to the workstation.

2. Connect the monitor to the workstation.

3. Plug the workstation power cord and monitor power cord into an AC outlet.

4. Connect other peripheral components (such as a printer) according to the instructions included
with the device.

5. Connect an Ethernet cable to the computer and to a network router or LAN device.
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Adding monitors

Planning for additional monitors

All graphics cards provided with your workstations support two simultaneous display monitors (See
Connecting and configuring monitors on page 19.). Cards that support more than two monitors are
available. The process for adding monitors depends on your graphics card(s) and the type and number
of monitors you add.

Use this process to plan for adding more monitors.

1. Assess your monitor needs:

● Determine how many monitors you require.

● Determine the kind of graphics performance you want.

● Note the type of graphics connector used by each monitor. HP provides graphics cards with
DisplayPort (DP) and DVI interfaces, but you can use adapters and third-party cards to
interface to other graphics formats, including DVI-I, HDMI, or VGA.

TIP: Some adapters for older hardware might cost more than others. You might want to
compare the cost of acquiring adapters with the cost of getting a newer monitor that doesn't
need adapters.

2. Determine if you need additional graphics cards:

● Consult the graphics card documentation to determine how many monitors you can connect
to the card.

You might need to acquire adapters to match the card connector to the monitor connector.
(See Matching graphics cards to monitor connectors on page 17.)

● If necessary, plan to acquire a new graphics card to drive additional monitors.

● The maximum number of monitors that a graphics card supports depends on the card. Most
cards provide outputs for two monitors. Some provide three or four outputs.
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NOTE: Monitors with resolutions above 1920 x 1200 pixels at 60 Hz require a graphics
card with either Dual Link DVI (DL-DVI) or DisplayPort output. To get native resolution with
DVI, you must use a DL-DVI cable, not standard DVI-I or DVI-D cables.

HP computers do not support all graphics cards. Make sure a new graphics card is
supported before purchasing it. See Finding supported graphics cards on page 17.

Many graphics cards provide more than two monitor outputs but limit you to using only two
at a time. Consult the graphics card documentation or look up information about the card
according to the procedure in Finding supported graphics cards on page 17.

Some graphics cards support multiple monitors by multiplexing the monitor signal across
multiple outputs. This might reduce graphics performance. Consult the graphics card
documentation or look up information about the card according to the procedure in Finding
supported graphics cards on page 17.

Make sure the card outputs match the input required by the monitors. (See Identifying monitor
connection requirements on page 18.)

The different models of workstations have different limits on the mechanical size, data speed,
and power available for additional graphics cards. In addition, the usual practical limit for
graphics cards is two per computer. Refer to the Maintenance and Service Guide for
expansion card slot identification to make sure a new graphics card will work for your
computer.

3. If you want to add a new graphics card or cards:

a. Determine which graphics card HP supports that will best fit your needs in terms of number of
monitors, compatibility with the monitors you plan to use, and performance. See Finding
supported graphics cards on page 17.

b. Make sure you have the correct drivers for the card.

c. Install the graphics card according to the video instructions for your workstation at
http://www.hp.com/go/sml.

d. Configure the monitor. For details, refer to Microsoft® Help or to http://www.microsoft.com,
or to your Linux Help website.

TIP: To simplify troubleshooting of possible problems, enable the monitors one at a time:
enable the first monitor and make sure it works properly before enabling the next monitor.

16 Chapter 3   Setting up the workstation

http://www.hp.com/go/sml
http://www.microsoft.com


Finding supported graphics cards

To find information about graphics cards supported for your workstation:

1. See http://www.hp.com/go/quickspecs.

2. In the left navigation bar under QuickSpecs, click your country, and then select Workstations.

3. Choose your model to view the specifications.

4. Click the link for Technical Specifications-Graphics. This displays expanded technical
information for supported graphics cards, including how many monitors the card supports,
connectors, power consumption, drivers, and other details.

Matching graphics cards to monitor connectors

NOTE: HP graphics cards include monitor cable adapters unless otherwise indicated.

DisplayPort cards have the highest performance; VGA graphics cards have the lowest.

The following table describes monitor configuration scenarios.

Graphics card connector

Monitor connector

VGA DVI
Dual-Link

DVI
DisplayPort

(DP)
HDMI

DISPLAYPORT DisplayPort-to-
VGA adapter

(sold separately)

DP-to-DVI
adapter

DP-to-DL DVI
adapter

DP cable
DP-to-HDMI

adapter

DVI-I
DVI-to-VGA

adapter or DVI-I
cable

DVI-D cable DL DVI cable N/A N/A

VGA

No adapter
required

DVI-I-to-VGA
adapter

N/A N/A N/A

DMS-59*

DMS-59-to-VGA
adapter

DMS-59-to-DVI
adapter

N/A
DMS-59-to-DP

adapter
N/A

* This interface is a dual-monitor graphics interface card that supports two VGA or two DVI monitors.
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Identifying monitor connection requirements

The following are various scenarios for connecting monitors. (See Matching graphics cards to monitor
connectors on page 17 for more information about the different graphics cards):

● Graphics card with DisplayPort output — If the graphics card has four DisplayPort outputs,
you can connect a monitor to each connector. Use the proper adapters if required.

● Graphics card with DVI output — If you have a PCIe graphics card with two DVI outputs,
you can connect a monitor to each connector. Use the proper adapters if required.

NOTE: Models that have only one DVI port always have a second graphics output option
(DisplayPort or VGA).

Many graphics cards provide more than two monitor outputs but limit you to using only two at a
time. Consult the graphics card documentation or look up information about the card according to
the procedure in Matching graphics cards to monitor connectors on page 17.

On a system with two DVI connections, port number 1 provides the primary display, which is
where the BIOS POST screen appears after a system boot. (Usually this is the lower of the two
outputs. Only one card is used during BIOS POST, although you can change this in the BIOS
settings.)

● Graphics card with VGA and DL-DVI output — If the workstation does not have a PCIe
graphics card, but has one or more SVGA and/or DL-DVI outputs, you can connect a monitor to
each output.

● Graphics card with DMS-59 output — If the workstation has a PCIe graphics card with a
DMS-59 output receptacle, use the appropriate adapter to connect your monitor.

Adapters are available to connect the DMS-59 output to two DVI or two VGA monitors.
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Connecting and configuring monitors

NOTE: The graphics cards that your workstation supports typically allow at least two monitors, as
shown in this section; some supported cards allow more monitors. Refer to the graphics card
documentation for details.

1. Connect the monitor cable adapters (1) (if required) to the workstation, and then connect the
appropriate monitor cables to the adapters (2) or directly to the graphics card.

2. Connect the other ends of the graphics cables to the monitors.

3. Connect one end of the monitor power cord to the monitor and the other end to a grounded
power outlet.

4. Configure the monitor. For details, refer to Microsoft Help or to http://www.microsoft.com, or to
your Linux Help or website.
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Using a third-party graphics configuration utility

Third-party graphics cards may include a monitor configuration utility. Upon installation, this utility is
integrated into Windows. You can select the utility and use it to configure multiple monitors with your
workstation.

Refer to your graphics card documentation for details.

NOTE: Some third-party configuration utilities require that you enable the monitors in Windows
before using the configuration tool. Refer to your graphics card documentation for more information.

NOTE: Monitor configuration utilities are also often available on the HP support website.

Customizing the monitor display (Windows)

You can manually select or change the monitor model, refresh rates, screen resolution, color settings,
font sizes, and power management settings.

● To change display settings in Windows 7, right-click a blank area on the desktop, and then click
Screen resolution.

● To change display settings in Windows 8, point to the upper-right or lower-left corner of the Start
screen to display the charms, and then click Settings > Control Panel > Appearance and
Personalization > Adjust Screen Resolution.

● For Windows 8, you can also change the display settings by pointing to the upper-right or lower-
left corner of the Start screen to display the Charms menu, and then clicking Search > Settings,
typing resolution in the Settings search field, and clicking Adjust Screen Resolution.

For more information about customizing your monitor display, refer to:

● Online documentation provided with the graphics controller utility

● Documentation included with your monitor
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Installing optional components
Depending on the workstation model, additional components (such as memory, hard drives, optical
drives, PCIe cards, or second processor) can be installed on your workstation.

● To view component installation videos, see http://www.hp.com/go/sml.

● For installation guidelines and technical information, refer to the Maintenance and Service Guide
for your workstation at http://www.hp.com/support/workstation_manuals.

Security
Some HP workstations have a lock on the side access panel. The key for this lock is shipped attached to
the back panel of the workstation chassis.

Additional security features reduce the risk of theft and warn of chassis intrusion. Refer to the
Maintenance and Service Guide for your workstation at http://www.hp.com/support/
workstation_manuals for information about additional hardware and software security features
available for your system.

Product recycling
HP encourages customers to recycle used electronic hardware, HP original print cartridges, and
rechargeable batteries.

For information about recycling HP components or products, see http://www.hp.com/go/recycle.
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4 Setting up, backing up, restoring,
and recovering Windows 7

This chapter provides setup and update information for the Windows 7 operating system. It includes
these topics:

Topics

Setting up the Windows 7 operating system on page 22

Backing up, restoring, and recovering Windows 7
on page 23

CAUTION: Do not add optional hardware or third-party devices to the HP workstation until the
operating system is successfully installed. Adding hardware might cause errors and prevent the
operating system from installing correctly.

NOTE: After you set up the operating system, be sure the latest BIOS, drivers, and software updates
are installed on the workstation. Refer to the chapter on updating the workstation.

Setting up the Windows 7 operating system
CAUTION: After installation has started, do not turn off the workstation until the process is complete.
Turning off the workstation during installation can damage the installation and operation of the
software.

For complete installation and configuration instructions, see http://windows.microsoft.com/en-US/
windows7/help. Additional information is available in the online help tool after you successfully install
the operating system.

Installing or upgrading device drivers

You must install the appropriate device drivers before you install hardware devices. Follow the
installation instructions that came with the device. For optimum performance, your operating system
must have the most recent updates, patches, and software fixes. For additional driver and software
update information, refer to the chapter on updating the workstation.
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Transferring files and settings

The Windows operating system offers data migration tools that help you select and transfer files and
data from one Windows-based computer to another.

For information about these tools, see http://www.microsoft.com.

Backing up, restoring, and recovering Windows 7
Your computer includes tools provided by HP and Windows to help you safeguard your information
and retrieve it if you ever need to. These tools will help you return your computer to a proper working
state or even back to the original factory state, all with simple steps.

This section provides information about the following processes:

● Creating recovery media and backups

● Restoring and recovering your system

NOTE: For more details about the Windows Backup and Restore tools provided, see Help and
Support. To access Help and Support, select Start > Help and Support.

Recovery after a system failure is only as good as your most recent backup.

1. After you successfully set up the computer, create recovery media. This media can be used to
reinstall the original operating system in cases where the hard drive is corrupted or has been
replaced. See Creating recovery discs with HP Recovery Disc Creator on HP Workstations
on page 26.

2. As you add hardware and software programs, create system restore points. A system restore point
is a snapshot of certain hard drive contents saved by Windows System Restore at a specific time.
A system restore point contains information that Windows uses, such as registry settings. Windows
creates a system restore point for you automatically during a Windows update and during other
system maintenance (such as a software update, security scanning, or system diagnostics). You
can also manually create a system restore point at any time. For more information and steps for
creating specific system restore points, see Help and Support. To access Help and Support, select
Start > Help and Support.

3. As you add photos, video, music, and other personal files, create a backup of your personal
information. If files are accidentally deleted from the hard drive and they can no longer be
restored from the Recycle Bin, or if files become corrupted, you can restore the files that you
backed up. In case of system failure, you can use the backup files to restore the contents of your
computer. See Backing up your information on page 23.

NOTE: HP recommends that you print the recovery procedures and save them for later use, in case of
system instability.

Backing up your information

NOTE: Windows includes the User Account Control feature to improve the security of your computer.
You may be prompted by User Account Control for your permission or password when you perform
certain tasks. To continue a task, select the appropriate option. For information about User Account
Control, see Help and Support: Select Start, and then select Help and Support.
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You should create your initial backup immediately after initial system setup. As you add new software
and data files, you should continue to back up your system on a regular basis to maintain a reasonably
current backup. Your initial and subsequent backups allow you to restore your data and settings if a
failure occurs.

NOTE: For detailed instructions on various backup and restore options, perform a search for these
topics in Help and Support. To access Help and Support, select Start > Help and Support.

You can back up your information to an optional external hard drive, a network drive, or discs.

Note the following when backing up your information:

● Store personal files in the Documents library, and back it up regularly.

● Back up templates that are stored in their associated directories.

● Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time-saver if you have to reset your preferences.

● When backing up to discs, number each disc after removing it from the drive.

To create a backup using Windows Backup and Restore:

NOTE: The backup process may take over an hour, depending on file size and the speed of the
computer.

1. Select Start > All Programs > Maintenance > Backup and Restore.

2. Follow the on-screen instructions to set up your backup.

System Restore

If you have a problem that might be due to software that you installed on your computer, use System
Restore to return the computer to a previous restore point. You can also set restore points manually.

NOTE: Always use this System Restore procedure before you use the System Recovery feature.

To start System Restore:

1. Close all open programs.

2. Click the Start button, right-click Computer, and then click Properties.

3. Click System protection, click System Restore, click Next, and then follow the on-screen
instructions.
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System Recovery

CAUTION: This procedure will delete all user information. To prevent loss of information, be sure to
back up all user information so you can restore it after recovery.

Always use the System Restore procedure before you use the System Recovery program. See System
Restore on page 24.

System Recovery completely erases and reformats the hard disk drive, deleting all data files that you
have created, and then reinstalls the operating system, programs, and drivers. However, you must
reinstall any software that was not installed on the computer at the factory. This includes software that
came on media included in the computer accessory box, and any software programs that you have
installed.

If you were not able to create system recovery DVDs, you can order a restore media set from support.
For U.S. support, see http://www.hp.com/support. For worldwide support, see http://www8.hp.com/
us/en/contact-hp/ww-contact-us.html. You can also order the restore media set by calling support.

NOTE: Some features might not be available on systems that are shipped without a Windows
operating system.

You must choose one of the following methods to perform a System Recovery:

● Recovery image — Run System Recovery from a recovery image stored on your hard disk drive.
The recovery image is a file that contains a copy of the original factory-shipped software. To
perform a System Recovery from a recovery image, see System Recovery from recovery partition
image on page 25.

● Recovery media — Run System Recovery from recovery media that you have created from files
stored on your hard disk drive or purchased separately. To create recovery media, see Creating
recovery discs with HP Recovery Disc Creator on HP Workstations on page 26.

System Recovery from recovery partition image

CAUTION: System Recovery deletes all data and programs that you have created or installed.

A Windows system from the HP factory ships with a recovery partition. You can use the recovery
partition to recover the factory operating system.

1. Turn off the computer. If necessary, press and hold the power button until the computer turns off.

2. Disconnect all peripheral devices from the computer except the monitor, keyboard, and mouse.

3. Press the power button to turn on the computer.

4. As soon as you see the HP logo screen, repeatedly press the f11 key on your keyboard until the
Windows is Loading Files... message appears on the screen.

5. At the HP Recovery Manager screen, follow the on-screen instructions to continue.

6. When Windows has loaded, shut down the computer, reconnect all peripheral devices, and then
turn the computer back on.
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Creating recovery discs with HP Recovery Disc Creator on HP Workstations

After you successfully set up the computer, create recovery media. The media can be used to reinstall
the original operating system in cases where the hard drive is corrupted or has been replaced.

HP Recovery Disc Creator is a software program that offers a way to create recovery discs on HP
Workstations. After you successfully set up the computer, you can create recovery discs using HP
Recovery Disc Creator if the hard drive becomes corrupted. The recovery discs allow you to reinstall
your original operating system as well as select drivers and applications. HP Recovery Disc Creator
creates two recovery discs:

● Windows 7 operating system DVD—Installs the operating system without additional drivers or
applications.

NOTE: The Windows 7 operating system DVD created by HP Recovery Disc Creator can only
restore the same format of boot disc that shipped from the factory. For Windows 7 64 bit, the
operating system DVD must be booted in UEFI mode which will result in a GPT boot disk. If an
MBR boot disk is desired, order recovery media from HP support.

● Driver DVD—Installs specific drivers and applications only.

To create recovery discs, your computer must have a DVD writer. The discs you use will depend on the
type of optical drive that you are using. Use any of the following types of discs (purchased separately):
DVD+R, DVD+R DL, DVD-R, DVD-R DL.

Creating recovery discs

NOTE: The Windows 7 operating system DVD can be created only once. Thereafter, the option to
create that media will not be available.

To create the Windows operating system DVD:

1. Insert a blank DVD into the DVD drive.

2. Select Start > All Programs > Productivity and Tools > HP Recovery Disc Creator.

3. Select Windows disc.

4. From the drop-down menu, select the DVD drive.

5. Click Create. After the disc is created, label it and store it in a secure place.

After the Windows 7 operating system DVD has been created, create the Driver DVD:

1. Insert a blank DVD into the DVD drive.

2. Select Start > All Programs > Productivity and Tools > HP Recovery Disc Creator.

3. Select Driver disc.

4. From the drop-down menu, select the DVD drive.

5. Click Create. After the disc is created, label it and store it in a secure place.
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Using HP Recovery Disc operating system discs

CAUTION: Using a Windows 7 operating system DVD completely erases hard drive contents and
reformats the hard drive. All files that you have created and any software that you have installed on the
computer are permanently removed. When reformatting is complete, the recovery process helps you
restore the operating system, as well as the original drivers, software, and utilities.

To create recovery media, see Creating recovery discs with HP Recovery Disc Creator on HP
Workstations on page 26.

Use the steps provided in this section if you used HP Recovery Disc Creator to create a Windows 7
operating system DVD and a Driver DVD.

If you cannot use the recovery discs that you created using the HP Recovery Disc Creator, you must
obtain a Windows 7 operating system DVD to reboot the computer and repair the operating system.

To order a Windows 7 operating system DVD and Driver DVD, see the HP website. For U.S. support,
see http://www.hp.com/cgi-bin/hpsupport/index.pl. For worldwide support, see
http://www8.hp.com/us/en/contact-hp/ww-contact-us.html. You can also order the DVDs by calling
support.

To initiate recovery using a Windows 7 operating system DVD:

NOTE: This recovery process takes several minutes.

1. Backup all personal files.

2. Restart the computer, and then insert the Windows 7 operating system DVD into the optical drive.

NOTE: If the computer does not boot to the DVD, restart the computer and press esc as the
computer is powering on to see the startup menu. Use the arrow keys to select the boot menu and
press enter. Use the arrow keys to select the location where the recovery DVD is inserted to boot
from that device. Booting the DVD from UEFI Boot sources will result in a GPT boot partition.
Booting from Legacy Boot sources will result in an MBR boot partition. A 32 bit OS will only
Legacy boot.

3. When prompted, press any keyboard key.

4. Follow the on-screen instructions.

5. Click Next.

6. Select Install now.

7. Follow the on-screen instructions.

After the repair is completed:

1. Eject the Windows 7 operating system DVD, and then insert the Driver DVD.

NOTE: The Driver DVD will load prerequisite software, and then allow you to load drivers and
applications.

2. Install the Hardware Enabling Drivers first. HP recommends installing all available drivers.

3. Install Recommended Applications of your choice. Only applications that are not available for
download from http://www.hp.com are included on the Driver DVD.
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5 Setting up, backing up, restoring,
and recovering Windows 8

This chapter provides setup and update information for the Windows 8 operating system. It includes
these topics:

Topics

Setting up the Windows 8 operating system on page 28

Backing up, restoring, and recovering Windows 8
on page 29

CAUTION: Do not add optional hardware or third-party devices to the HP workstation until the
operating system is successfully installed. Adding hardware might cause errors and prevent the
operating system from installing correctly.

NOTE: After you set up the operating system, be sure that the latest BIOS, drivers, and software
updates are installed on the workstation. Refer to the chapter on updating the workstation.

Additional information
Additional information is available in Help and Support after you customize the operating system.

Setting up the Windows 8 operating system

The first time you turn on the computer you can customize the operating system. When you are
connected to the Internet, Microsoft activates your operating system. This process takes about 15 to 30
minutes. Carefully read and follow the instructions on the screen.

We recommend that you register your computer with HP, so you can receive important software
updates, request support, and sign up for special offers. You can register your computer with HP using
the Register with HP app on the Start screen.

CAUTION: After the initial setup process has begun, DO NOT TURN OFF THE COMPUTER UNTIL
THE PROCESS IS COMPLETE. Turning off the computer during this process may damage the software
that runs the computer or prevent its proper installation.

NOTE: Windows includes the User Account Control feature to improve the security of your computer.
You may be prompted by User Account Control for your permission or password when you perform
certain tasks. To continue a task, select the appropriate option. For information about User Account
Control, see Help and Support: Select Start, and then select Help and Support.
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Downloading Windows 8 updates

Microsoft may release updates to the operating system. To help keep the computer running optimally,
HP recommends checking for the latest updates during the initial installation and periodically
throughout the life of the computer.

Run Windows Update as soon as possible after you set up your computer.

1. Point to the upper-right or lower-right corner of the Start screen to display the charms.

2. Click Settings > Change PC Settings > Windows Update.

Backing up, restoring, and recovering Windows 8
Your computer includes tools provided by HP and Windows to help you safeguard your information
and retrieve it if you ever need to. These tools will help you return your computer to a proper working
state or even back to the original factory state, all with simple steps.

This section provides information about the following processes:

● Creating recovery media and backups

● Restoring and recovering your system

NOTE: For more details about the tools provided, see Help and Support. From the Start screen, type
h, and then select Help and Support.

HP recommends that you print the recovery procedures and save them for later use, in case of system
instability.

Backing up your information

NOTE: Windows includes the User Account Control feature to improve the security of your computer.
You may be prompted by User Account Control for your permission or password when you perform
certain tasks. To continue a task, select the appropriate option. For information about User Account
Control, see Help and Support: Select Start, and then select Help and Support.

Recovery after a system failure is as good as your most recent backup. You should create system repair
media and your initial backup immediately after initial system setup. As you add new software and
data files, you should continue to back up your system on a regular basis to maintain a reasonably
current backup. The system repair media is used to start up (boot) the computer and repair the
operating system in case of system instability or failure. Your initial and subsequent backups allow you
to restore your data and settings if a failure occurs.

NOTE: For detailed instructions on various backup and restore options, perform a search for these
topics in Help and Support. To access Help and Support, select Start > Help and Support.

Type backup on the Start screen, click Settings, and then select Save backup copies of your
files with File History.

You can back up your information to an optional external hard drive, or a network drive.
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Note the following when backing up:

● Store personal files in the Documents library, and back it up regularly.

● Back up templates that are stored in their associated programs.

● Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time-saver if you have to reset your preferences.

To create a backup using Windows Backup and Restore:

NOTE: The backup process may take over an hour, depending on file size and the speed of the
computer.

1. From the Start screen, type backup, click Settings, and then select from the list of displayed
options.

2. Follow the on-screen instructions to set up your backup, create a system image, or create system
repair media.
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Creating recovery media and backups

Recovery after a system failure is only as good as your most recent backup.

CAUTION: Use a flash drive with a capacity of at least 8 GB. Any information about the USB flash
drive will be erased before the recovery media is created.

1. After you successfully set up the computer, create recovery media. This step creates a backup of
the recovery partition on the computer. The backup can be used to reinstall the original operating
system in cases where the hard drive is corrupted or has been replaced.

You will use a USB flash drive to create a bootable recovery drive that can be used to troubleshoot
a Windows 8 computer that is unable to start. The USB flash drive can be used to reinstall the
original operating system and the programs that were installed at the factory.

CAUTION: If you select the Copy contents from the recovery partition to the recovery drive,
when the Recovery Media creation has completed, you will have an option to delete the recovery
partition. On most systems, this partition is 10 GB in size. HP recommends not to delete this
recovery partition. If the partition is deleted, you will be unable to restore the Windows 8 OEM
factory recovery partition to the hard drive using the recovery USB drive. You can free up drive
space by deleting the recovery partition but you won't be able to refresh or reset the PC again.

To create the recovery media, from the Start screen, type recovery drive, click Settings, and
then click Create a recovery drive. Follow the on-screen instructions to continue.

2. As you add hardware and software programs, create system restore points. A system restore point
is a snapshot of certain hard drive contents saved by Windows System Restore at a specific time.
A system restore point contains information that Windows uses, such as registry settings. Windows
creates a system restore point for you automatically during a Windows update and during other
system maintenance (such as a software update, security scanning, or system diagnostics). You
can also manually create a system restore point at any time. For more information and steps for
creating specific system restore points, see Windows Help and Support. From the Start screen,
type h, and then select Help and Support.

3. As you add photos, video, music, and other personal files, create a backup of your personal
information. Windows File History can be set to regularly and automatically back up files from
libraries, desktop, contacts, and favorites. If files are accidentally deleted from the hard drive and
they can no longer be restored from the Recycle Bin, or if files become corrupted, you can restore
the files that you backed up using File History. Restoring files is also useful if you ever choose to
reset the computer by reinstalling Windows.

NOTE: File History is not enabled by default, so you must turn it on.

For more information and steps for enabling Windows File History, see Windows Help and
Support. From the Start screen, type h, and then select Help and Support.
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Restoring and recovering using Windows 8 tools

Windows recovery tools provide access to several options for recovering your system. Choose the
method that best matches your situation and level of expertise:

● If you need to restore your personal files and data, you can use Windows File History to restore
your information from the backups you created. For more information and steps for using File
History, see Windows Help and Support. From the Start screen, type h, and then select Help
and Support.

● If you want to restore the system to a previous state without losing any personal information,
Windows System Restore is an option. System Restore allows you to restore without the
requirements of Windows Refresh or a reinstallation. Windows creates system restore points
automatically during a Windows update and other system maintenance events. Even if you did not
manually create a restore point, you can choose to restore to an automatically created restore
point. For more information and steps for using Windows System Restore, see Windows Help and
Support. From the Start screen, type h, and then select Help and Support.

● If you want a quick and easy way to recover the system without losing your personal information,
settings, or apps that came preinstalled on your computer or were purchased from the Windows
Store, Windows Refresh is an option. This method does not require backing up data to another
drive. See Using Windows 8 Refresh on page 32.

● If you want to reset your computer to its original state, Windows Reset provides an easy way to
remove all personal data, apps, and settings, and reinstall Windows. The Reset recovery tool
reinstalls the operating system and HP programs and drivers that were installed at the factory.
Software not installed at the factory must be reinstalled. Any personal files must be restored from
backups you made. See Using Windows 8 Reset on page 33.

● If the computer is unable to start, you can use the Windows recovery USB flash drive you created
to recover the system. See Recovery using the Windows 8 recovery USB flash drive on page 34.

● If the computer is unable to start and you did not create a recovery USB flash drive, or the one you
created does not work, see Recovery using Windows 8 restore media on page 35.

Using Windows 8 Refresh

IMPORTANT: Refresh removes any traditional applications that were not originally installed on the
system at the factory.

NOTE: You may be prompted by User Account Control for your permission or password when you
perform certain tasks. To continue a task, select the appropriate option. For information about User
Account Control, see Help and Support: Select Start, and then select Help and Support.

If Windows is responding, use these steps to start Refresh:

NOTE: During Refresh, a list of removed traditional applications will be saved so that you have a
quick way to see what you might need to reinstall. See Help and Support for instructions on reinstalling
traditional applications. From the Start screen, type h, and then select Help and Support.

1. On the Start screen, point to the far-right upper or lower corner of the screen to display the
charms.

2. Click Settings.
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3. Click Change PC settings in the bottom-right corner of the screen, and then select General
from the PC settings screen.

4. Under Refresh your PC without affecting your files, select Get started, and follow the
on-screen instructions.

If Windows is not responding, use these steps to start Refresh:

1. If possible, back up all personal files.

2. If possible, check for the presence of the HP Recovery partition: From the Start screen, type c, and
then select Computer.

NOTE: If the HP Recovery partition is not listed, or you cannot check for its presence, you must
recover using the recovery media that you created. See Recovery using the Windows 8 recovery
USB flash drive on page 34. If you did not create recovery media, you must use the Windows 8
restore media (available separately). See Recovery using Windows 8 restore media
on page 35.

3. If the HP Recovery partition is listed, restart the computer, and then press esc while the company
logo is displayed. The computer Startup Menu opens.

4. Press f11 to select the System Recovery option.

5. Choose your keyboard layout.

6. Select Troubleshoot.

7. Select Refresh.

8. Follow the on-screen instructions to continue.

Using Windows 8 Reset

IMPORTANT: Reset does not provide backups of your information. Before using Reset, back up any
personal information you wish to retain.

If Windows is responding, use these steps to start Reset:

NOTE: You may be prompted by User Account Control for your permission or password when you
perform certain tasks. To continue a task, select the appropriate option. For information about User
Account Control, see Help and Support: Select Start, and then select Help and Support.

1. On the Start screen, point to the far-right upper or lower corner of the screen to display the
charms.

2. Click Settings.

3. Click Change PC settings in the bottom-right corner of the screen, and then select General
from the PC settings screen.

4. Under Remove everything and reinstall Windows, select Get started, and follow the
on-screen instructions.

Backing up, restoring, and recovering Windows 8 33



If Windows is not responding, use these steps to start Reset:

1. If possible, back up all personal files.

2. If possible, check for the presence of the HP Recovery partition: From the Start screen, type c, and
then select Computer.

NOTE: If the HP Recovery partition is not listed, or you cannot check for its presence, you must
recover using the recovery media that you created. See Recovery using the Windows 8 recovery
USB flash drive on page 34. If you did not create recovery media, you must use the Windows 8
restore media (available separately). See Recovery using Windows 8 restore media
on page 35.

3. If the HP Recovery partition is listed, restart the computer, and then press esc while the company
logo is displayed. The computer Startup Menu opens.

4. Press f11 to select the System Recovery option.

5. Choose your keyboard layout.

6. Select Troubleshoot.

7. Select Reset.

8. Follow the on-screen instructions to continue.

Recovery using the Windows 8 recovery USB flash drive

CAUTION: Using f11 completely erases hard drive contents and reformats the hard drive. All files
that you have created and any software that you have installed on the computer are permanently
removed. The f11 recovery tool reinstalls the operating system and the HP programs and drivers that
were installed at the factory. You must reinstall all other software.

To recover your system using the recovery USB flash drive you previously created:

NOTE: If you did not create a recovery USB flash drive or the one you created does not work, see
Recovery using Windows 8 restore media on page 35.

1. If possible, back up all personal files.

2. Insert the recovery USB flash drive into a USB port on your computer.

3. Restart the computer and as soon as you see the HP logo screen, press f9 to display a list of boot
devices. Use the arrow keys to select your USB flash drive from the UEFI Boot Sources list. Press
enter.

4. Choose your keyboard layout.

5. Select Troubleshoot.

6. Select Refresh your PC.

7. Follow the on-screen instructions.
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Recovery using Windows 8 restore media

This recovery process requires Windows 8 restore disc, which can be ordered from the support
website. The Windows 8 restore media consists of a Windows 8 operating system disc and a
Windows 8 driver disc.

For U.S. support, see http://www.hp.com/support. For worldwide support, see http://www8.hp.com/
us/en/contact-hp/ww-contact-us.html. You can also order the media by calling support.

CAUTION: Using Windows 8 operating system disc completely erases hard drive contents and
reformats the hard drive. All files that you have created and any software that you have installed on the
computer are permanently removed. When reformatting is complete, the recovery process helps you
restore the operating system, as well as drivers, software, and utilities.

Begin recovery using Windows 8 operating system disc:

NOTE: It can take several minutes to load the operating system disc.

1. Back up all personal files.

2. Restart the computer, and then follow the instructions provided with the Windows 8 operating
system disc to install the operating system.

3. When prompted, press any keyboard key.

NOTE: If the computer does not boot to the DVD, restart the computer and press esc as the
computer is powering on to see the startup menu. Use the arrow keys to select the boot menu and
press enter. Use the arrow keys to select the location where the recovery DVD is inserted to boot
from that device. Booting the DVD from UEFI Boot sources will result in a GPT boot partition.
Booting from Legacy Boot sources will result in an MBR boot partition. It is recommended that you
boot Windows 8 from UEFI Boot sources to take full advantage of the features available in
Windows 8.

4. Follow the on-screen instructions.

After the repair is completed and the Windows 8 desktop appears:

1. Remove the Windows 8 operating system disc, and then insert the driver disc.

NOTE: The driver disc will load prerequisite software, and then allow you to load drivers and
applications.

2. Install the Hardware Enabling Drivers first, and then install Recommended Applications.

3. Install Recommended Applications of your choice. Only applications that are not available for
download from http://www.hp.com are included on the driver disc.

Backing up, restoring, and recovering Windows 8 35

http://www.hp.com/support
http://www8.hp.com/us/en/contact-hp/ww-contact-us.html
http://www8.hp.com/us/en/contact-hp/ww-contact-us.html
http://www.hp.com


6 Setting up and restoring Linux

This chapter describes how to set up and restore the Linux® operating system. It includes these topics:

Topics

HP Installer Kit for Linux on page 37

Setting up Red Hat Enterprise Linux on page 37

Setting up SUSE Linux Enterprise Desktop on page 39

Proprietary graphics drivers on page 40

NOTE: After you set up the operating system, make sure the latest BIOS, drivers, and software
updates are installed. Refer to the chapter on updating the workstation.

CAUTION: Do not add optional hardware or third-party devices to the workstation until the
operating system is successfully installed. Adding hardware might cause errors and prevent the
operating system from installing correctly.

HP Linux Support Matrix
Not all release streams are supported on particular platforms. To find out which streams are supported
on your workstation. refer to the Linux certification and support matrix:

1. See http://www.hp.com/linux.

2. In the Platforms tab, select HP Workstations.

3. Select your operating system under Certification Matrix..

36 Chapter 6   Setting up and restoring Linux

http://www.hp.com/linux


HP Installer Kit for Linux
The HP Installer Kit for Linux (HPIKL) helps users install certified versions of Linux on HP workstations. It is
available as an operating system option on all HP workstations. The kit:

● Contains tested drivers that augment and/or replace those found in the Linux operating system to
enable proper use and behavior on HP workstations.

● Does not include Linux operating system, which must be purchased separately from Red Hat or
SUSE. To view supported configurations and operating systems, see http://www.hp.com/
support/linux_hardware_matrix.

The HPIKL option includes a FreeDOS preload. This operating system option accommodates those who
have a customized Linux distribution, or who have a licensed version of a Linux operating system and
would like to install the HP-recommended driver additions.

The kit also can be downloaded:

1. See http://www.hp.com/support/workstation_swdrivers.

2. Select your workstation model.

3. Select the desired operating system.

4. Select your software/driver language, and then click the Software quick jump link.

5. Click the Obtain Software link for the appropriate package (typically the most recent revision).

6. Click I Agree to accept the terms of the license agreement.

7. Download the software ISO image and save it on a disc. This disc is your HP driver disc.

Setting up Red Hat Enterprise Linux
HP workstations are certified and supported on RHEL streams appropriate to the hardware technology.

● For details of RHEL support for a particular platform, see the Hardware Support Matrix for HP
Linux Workstations at http://www.hp.com/support/linux_hardware_matrix.

● For information about Red Hat certifications on HP workstations, see
https://hardware.redhat.com.
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HPIKL driver disc

Recent versions of Red Hat Linux typically require only driver updates with minor fixes to support HP
workstations. These releases can usually be supported with the HPIKL driver disc, which can be used as
a post-installation utility for the standard Red Hat Linux install.

After you complete the standard Red Hat install and restart the system, a Red Hat first-boot utility runs.
After you specify a number of settings (such as the security level, time and date, root password, user
accounts), the utility lets you to load additional disc.

The driver disc is used during this phase. All content added by HP is in the /HP directory on the disc.
You can use it to build your own image or to browse the HP content.

NOTE: Some installations may encounter problems if they are performed with a DisplayPort
connection to the monitor. This is because the default drivers that the OS installers use do not support
DisplayPort functionality. If you experience problems, try overriding the monitor choice for DisplayPort
during the start of the install and using the VESA driver instead. You can then set up the DisplayPort
monitor later.

Installing with the HP Red Hat Linux driver disc

1. If you do not have the appropriate HP driver disc for a supported stream, create one (see HP
Installer Kit for Linux on page 37).

2. Install the operating system using the discs included in the Red Hat Linux box-set.

3. If you have a Red Hat driver disc for the operating system version you are installing, enter
linux dd on the install splash screen, and then press enter.

4. When asked if you have a driver disc, select Yes. Place the Red Hat driver disc in the drive, and
select the appropriate drive:hd[abcd]. Continue the normal installation.

5. After successfully installing the operating system, reboot the workstation.

● RHEL 5: the Red Hat Setup Agent (also known as first-boot) automatically starts. At the
Additional DVDs screen, insert your HP driver disc and select Install. When the driver
installation task is completed, continue following the prompts until the operating system is
successfully installed.

● RHEL 6: Insert your HP driver disc. The HPIKL installation software automatically starts. Follow
the prompts to install the contents.
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Setting up SUSE Linux Enterprise Desktop
SUSE Linux Enterprise Desktop (SLED) is preloaded or supported on some workstations.

Various versions of SLED are certified and supported by SUSE on HP workstations. For more
information, refer to the SUSE certification bulletin search page at http://www.suse.com/yessearch/
Search.jsp.

Setting up preloaded SLED

To set up SLED on systems preloaded with the operating system:

1. Start the workstation.

2. When prompted, enter the workstation installation settings: password, network, graphics, time,
keyboard settings, and SUSE Customer Center Configuration.

NOTE: You can activate your SUSE subscription from the SUSE Customer Center Configuration
screen. To view the full SUSE Customer Center documentation, see http://www.suse.com/
documentation and select your operating system.

Installing SLED with the DVD Installer Kit

1. If an HP driver disc did not come with your workstation, create one (see HP Installer Kit for Linux
on page 37).

2. Install the operating system using the discs included in the SUSE box-set.

3. After successfully installing the operating system, reboot the workstation.

4. Insert your HP driver disc. The HPIKL installation software automatically starts. Follow the prompts
to install the contents.
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Restoring SLED (preloaded systems only)

The SLED restore media is required to restore the Linux operating system. To create restore media:

1. Click the SUSE ISO icon on the desktop to see the /iso folder. This folder contains all iso images
used to preload your workstation.

2. Follow the instructions in the readme file in this folder to copy the ISO image file onto optical
media.

3. Store the media in a safe place. If your workstation experiences a hard drive failure, use the ISO
recovery images tor restore your operating system.

CAUTION: Restoring the operating system does not restore data. Back up your data using the
method and media of your choice.

Proprietary graphics drivers
Most HP workstations can be ordered with graphics cards that have been through extensive verification
by HP. See the Hardware Support Matrix for HP Linux Workstations at http://www.hp.com/support/
linux_hardware_matrix for a list of supported cards.

NOTE: Not all graphics cards are available on every workstation. Limitations generally occur for
cards that consume large amounts of power in lower-power workstations.

Proprietary graphics drivers supported by HP and the graphics vendors are available with the HP
Installer Kit for Linux, with the SLED preload on workstations, and from HP Workstation Support at
http://www.hp.com/go/workstationsupport.

These proprietary drivers are not a standard part of the RHEL or SLED distributions because they are not
open source. Driver revisions more recent than those at the HP support website are supported directly
by the vendor.
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7 Updating the workstation

HP is constantly working on improving your total workstation experience. To ensure that the workstation
leverages the latest enhancements, HP recommends that you install the latest BIOS, driver, and software
updates on a regular basis.

Updating the workstation after first boot
After successfully booting the workstation for the first time, you should follow these guidelines to ensure
that the workstation is up-to-date:

● Ensure that you have the latest system BIOS loaded. See Upgrading the BIOS on page 41.

● Ensure that you have the latest drivers for your system. See Upgrading device drivers
on page 42.

● Become familiar with your available HP resources.

● Consider a subscription to Driver Alerts at http://www.hp.com/go/subscriberschoice.

Upgrading the BIOS
For optimum performance, determine the BIOS revision on the workstation, and upgrade it if necessary.

Determining the current BIOS version

To determine the current BIOS version:

1. Restart the computer, and then press esc while the company logo is displayed. The computer
Startup Menu appears.

2. Press f10 to enter Computer (f10) Setup Utility.

3. Select File > System Information. Note the workstation BIOS version and compare it with the
BIOS versions that appear on the HP website.

NOTE: For BIOS Menu settings in Computer (f10) Setup utility as well as procedures for
upgrading the BIOS, see the Maintenance and Service Guide at http://www.hp.com/support/
workstation_manuals.
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Upgrading BIOS

To find and download the latest available BIOS, which includes the latest enhancements:

1. See http://www.hp.com/go/workstationsupport.

2. Select Download Drivers and Software from the left menu column under Tasks.

3. Follow the instructions to locate the latest BIOS available for the workstation.

4. If the BIOS on the website is the same as the version on your system, no further action is required.

5. If the BIOS on the website is a version later than the one on your system, download the
appropriate version for the workstation. Follow the instructions in the release notes to complete the
installation.

Upgrading device drivers
If you install a peripheral device (such as a printer, display adapter, or network adapter), confirm you
have the latest device drivers loaded. If you purchased your device through HP, visit the HP website to
download the latest drivers for your device. These drivers have been tested to ensure the best
compatibility between your device and your HP workstation.

If you did not purchase your device from HP, HP recommends visiting the HP website first to see if your
device and its drivers have been tested for HP workstation compatibility. If no driver is available, visit
the device manufacturer's website to download the latest drivers.

To upgrade device drivers:

1. See http://www.hp.com/go/workstationsupport.

2. Under Tasks in the left column, select Download Drivers and Software.

3. Follow the instructions to find the latest drivers available for the workstation.

If a needed driver is not found, see the website of the manufacturer of the peripheral device.
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8 Diagnostics and Minor
Troubleshooting

Calling support
At times you might encounter an issue that requires support. When you call support:

● Have the computer readily accessible.

● Write down the computer serial numbers, product numbers, model names, and model numbers
and have them in front of you.

● Note any applicable error messages.

● Note any add-on options.

● Note the operating system.

● Note any third-party hardware or software.

● Note the details of any blinking LEDs on the front of the computer (tower and desktop
configurations) or on the side of the computer (all-in-one configurations).

● Note the applications you were using when you encountered the problem.

NOTE: When calling in for service or support, you might be asked for the product number (example:
PS988AV) of the computer. If the computer has a product number, it is generally located next to the 10-
or 12-digit serial number of the computer.

NOTE: On most models, the serial number and product number labels can be found on the top or
side panel and at the rear of the computer (tower and desktop configurations) or on a pull-out card on
the side of the display (all-in-one configurations).

For a listing of all worldwide support phone numbers, see http://www.hp.com/support, select your
region, and click Connect with HP in the upper-right corner.
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Locating identification labels
To assist in troubleshooting, product, serial, and authentication numbers are available on each
computer.

● All workstations have a serial number (unique for each workstation) and product number. Have
these numbers available when you contact support.

● The Certificate of Authentication (COA) is used for Windows 7-preinstalled systems only.

● The Genuine Microsoft Label (GML) is used for Windows 8-preinstalled systems only.

● A service label shows the build ID and Feature Byte strings, which are needed for system board
replacement.

In general, these labels can be found in the top, rear, or bottom of the chassis (tower and desktop
configuration) (your computer might look different).

Locating warranty information
To locate base warranty information, see http://www.hp.com/support/warranty-lookuptool.

To locate an existing Care Pack, see http://www.hp.com/go/lookuptool.

To extend a standard product warranty, visit http://www.hp.com/hps/carepack. HP Care Pack
Services offer upgraded service levels to extend and expand a standard product warranty.
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HP troubleshooting resources and tools
This section provides information about the online support and helpful hints for troubleshooting.

Online support

Online access and support resources include web-based troubleshooting tools, technical knowledge
databases, driver and patch downloads, online communities, and product change notification services.

The following websites are also available to you:

● http://www.hp.com — Useful product information

● http://www.hp.com/support/workstation_manuals — The latest online documentation

● http://www.hp.com/go/workstationsupport — Technical support information for workstations

● http://welcome.hp.com/country/us/en/wwcontact_us.html — Worldwide support (chat with a
technician, obtain email support, find support numbers, or locate an HP service center)

● http://www.hp.com/support/workstation_swdrivers — Software and drivers for workstations

Troubleshooting a problem

To help you troubleshoot problems with your system, HP provides the Business Support Center (BSC).
The BSC is a portal to an extensive selection of online tools. To access BSC and troubleshoot a problem
with the workstation, complete the following:

1. Visit http://www.hp.com/go/workstationsupport.

2. Under the Business Support Center menu on the left, select Troubleshoot a problem.

3. Under Select your product (center window), select Workstations (under personal
computing).

4. Under Select your product, continue with selections as appropriate to the workstation series
and model, and to the problem you are troubleshooting.

Instant Support and Active Chat

Active Chat enables you to electronically submit a support ticket to HP over the Internet. When you
submit a support ticket, Active Chat collects information about the computer and passes it to an online
support specialist. The collection of information might take up to 30 seconds, depending on the
computer configuration. When you submit a support ticket, you receive a confirmation message
containing your case ID, the support hours for your location, and the estimated time of response.

For more information about HP Instant Support and Active Chat and how to use them, see
http://instantsupport.hp.com/.

NOTE: This feature is not available on Linux.
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Customer Advisories, Customer and Security Bulletins, and Customer Notices

To find advisories, bulletins, and notices:

1. Visit http://www.hp.com/go/workstationsupport.

2. Select the desired product.

3. Under Resources for <your selected product>, select See more….

4. Under Self-Help resources: in the center of the window, choose the desired action and
appropriate information in the scroll list to view the index.

Product Change Notifications

Product Change Notifications (PCNs) are proactive notifications for product changes occurring within a
30 to 60 day window of the manufacturing process change date. PCNs give customers advanced
notice of changes to their product, such as an updated BIOS version. The latest PCNs are located at:
http://www.hp.com/go/workstationsupport. Select your product, and then under Resources for the
HP Workstation, click See more.

Helpful hints

If you encounter a problem with the workstation, monitor, or software, the following general
suggestions might help you isolate and focus on the problem before taking further action.

At startup

● Verify that the workstation and monitor are plugged into a working electrical outlet.

● Remove all optical discs and USB drive keys from the drives before powering on the workstation.

● Verify that the workstation is turned on and the power light is on.

● If you have installed an operating system other than the factory-installed operating system, check
to be sure that it is supported on your system by visiting http://www.hp.com/go/quickspecs.

● Verify that the monitor is turned on and the green monitor light is on.

● Turn up the brightness and contrast controls of the monitor if the monitor is dim.

● If the workstation has multiple video sources and only a single monitor, the monitor must be
connected to the source selected as the primary VGA adapter. During startup, the other monitor
connections are disabled; if the monitor is connected to one of these ports, it will not function after
Power-on Self Test (POST). You can select the default VGA source in Computer (f10) Setup Utility.
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During operation

● Look for blinking LEDs on the workstation. The blinking lights are error codes that will help you
diagnose the problem. Refer to the Diagnostic lights and audible (beep) codes section in the
Maintenance and Service Guide for your workstation for information about interpreting diagnostic
lights and audible codes.

● Press and hold any key. If the system beeps, your keyboard is operating correctly.

● Check all cables for loose or incorrect connections.

● Wake the workstation by pressing any key on the keyboard or the power button. If the system
remains in suspend mode, shut down the system by pressing and holding the power button for at
least four seconds, and then press the power button again to restart the system. If the system does
not shut down, unplug the power cord, wait a few seconds, and then plug it in again. If it does
not restart, press the power button to start the workstation.

● Reconfigure the workstation after installing a non–plug and play expansion board or other option.
Refer to the Hardware installation problems section of this document for instructions.

● Be sure that all required device drivers have been installed. For example, if you have connected a
printer, you must install a printer driver.

● If you are working on a network, plug another workstation with a different cable into the network
connection. There might be a problem with the network plug or cable.

● If you recently added new hardware, remove the hardware and verify if the workstation functions
properly.

● If you recently installed new software, uninstall the software and verify if the workstation functions
properly.

● If the monitor connected to a tower, desktop or all-in-one computer is blank:

◦ Plug the monitor into a different video port on the computer if one is available. Alternatively,
replace the monitor with a monitor that you know is working properly.

◦ Verify that the computer and monitor are plugged into a working electrical outlet.

◦ Verify that the monitor is turned on and the green monitor light is on.

◦ Turn up the brightness and contrast controls of the monitor if the monitor is dim.

● If the internal display on an all-in-one computer is blank, open the computer and make sure the
graphics card is properly installed.

● Upgrade the BIOS. A new release of the BIOS might have been released that supports new
features or fixes your problem.

● For more detailed information, see the troubleshooting chapter in the Maintenance and Service
Guide at http://www.hp.com/support/workstation_manuals.
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Customer self-repair

Under the Customer self-repair program, you can order a replacement part and install the part without
onsite HP technical assistance. Customer self repair may be required for some components. See
http://www.hp.com/go/selfrepair for information about the program.

NOTE: Some components are not eligible for customer self-repair and must be returned to HP for
service. Call HP Support for further instructions before attempting to remove or repair these
components.

Other troubleshooting options

The following additional troubleshooting techniques and tools are located in the Maintenance and
Service Guide at http://www.hp.com/support/workstation_manuals:

● POST Error Codes

● Diagnostic LEDs and audible beep codes

● Troubleshooting scenarios and solutions

● HP PC Hardware Diagnostics UEFI
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9 Routine Care

General cleaning safety precautions
● Never use solvents or flammable solutions to clean the computer.

● Never immerse any component in water or cleaning solutions; apply any liquids to a clean cloth
and then use the cloth on the component.

● Always unplug the computer before cleaning the keyboard, mouse, or air vents.

● Always disconnect the keyboard before cleaning it.

● Wear safety glasses equipped with side shields when using compressed air, to prevent dust and
debris from getting into your eyes.

Cleaning products
Use the following products to safely clean your computer:

● Dimethyl benzyl ammonium chloride 0.3 percent maximum concentration, usually in the form of
disposable wipes in a variety of brand names.

● Alcohol-free glass cleaning fluid

● Water with mild soap solution

● Dry microfiber cleaning cloth or a chamois (static-free cloth without oil)

● Static-free cloth wipes

CAUTION: Avoid strong cleaning solvents that can permanently damage your computer. If you
are not sure if a cleaning product is safe for your computer, check the product contents to make
sure that ingredients such as alcohol, acetone, ammonium chloride, methylene chloride, and
hydrocarbons are not included.

● Fibrous materials, such as paper towels, can scratch the computer. Over time, dirt particles and
cleaning agents can get trapped in the scratches.
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Cleaning the chassis
● Follow the safety precautions in the Maintenance and Service Guide for your workstation before

cleaning the computer.

● To remove light stains or dirt, use plain water with a clean, lint-free cloth or swab.

● For stronger stains, use a soft microfiber cloth or chamois moistened with mild dish washing liquid
diluted with water. Rinse well by wiping it with a cloth or swab dampened with clear water.

● After cleaning, always wipe the computer with a clean, lint-free cloth.

● Occasionally, clean the air vents on the computer. Lint and other foreign matter can block the
vents and limit the airflow.

Cleaning the keyboard
● If the keyboard has an on/off switch, turn it off.

● Follow the safety precautions in the Maintenance and Service Guide for your workstation before
cleaning the computer.

● Visible debris underneath or between the keys can be removed by vacuuming or shaking.

● Canned, pressurized air can be used to clean debris from under the keys. Use caution because
too much air pressure can dislodge lubricants applied under the wide keys.

● If you remove a key, use a specially designed key remover to prevent damage to the keys. This
tool is available from many electronic supply outlets.

CAUTION: Never remove a wide key (like the space bar key) from the keyboard. If these keys
are improperly removed or installed, the keyboard might not function properly.

● Clean under a key with a swab moistened with one of the products mentioned in Cleaning
products on page 49 of this guide. Be careful not to wipe away lubricants necessary for proper
key functions. Allow the parts to air dry before reassembly.

● Use tweezers to remove any fibers or dirt in confined areas.

Cleaning the monitor
● Follow the safety precautions in the Maintenance and Service Guide for your workstation before

cleaning the computer.

● Gently wipe the display using a soft, lint-free cloth moistened with water or an alcohol-free glass
cleaner.

CAUTION: Do not use sprays or aerosols directly on the screen—the liquid might seep into the
housing and damage a component.

Never use solvents or flammable liquids on the monitor because display or housing damage may
result.
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Cleaning the mouse
1. Follow the safety precautions in the Maintenance and Service Guide for your workstation before

cleaning the computer.

2. If the mouse has an on/off switch, turn it off.

3. Wipe the body of the mouse with a soft microfiber cloth or chamois moistened with alcohol-free
glass cleaning fluid or water with mild soap solution.

4. If the mouse has a:

● Laser or LED: use a cotton swab dampened with cleaning solution to gently brush out any
dust around the laser or LED, and then wipe again with a dry swab. Do not wipe the laser or
LED directly with the swab.

● Scroll wheel: spray canned, pressurized air in the gap between the scroll wheel and the click
buttons. Do not blow air directly on one spot for very long or condensation can form.

● Roller ball: remove and clean the roller ball, remove any debris from the ball socket, wipe out
the socket with a dry cloth, and reassemble the mouse.
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